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New in this release
This is a new document created to support Communication Server 1000
Release 7.0.

Other Changes
Revision History

June 2010
Standard 01.01. This is a new document created to support
Communication Server 1000 Release 7.0.
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How to get help
This chapter explains how to get help for Nortel products and services.

Getting help from the Nortel Web site
The best way to get technical support for Nortel products is from the Nortel
Technical Support Web site:

http//www.nortel.com/support

This site provides quick access to software, documentation, bulletins, and
tools to address issues with Nortel products. From this site, you can:

• download software, documentation, and product bulletins

• search the Technical Support Web site and the Nortel Knowledge Base
for answers to technical issues

• sign up for automatic notification of new software and documentation
for Nortel equipment

• open and manage technical support cases

Getting help over the telephone from a Nortel Solutions Center
If you do not find the information you require on the Nortel Technical
Support Web site, and you have a Nortel support contract, you can also
get help over the telephone from a Nortel Solutions Center.

In North America, call 1-800-4NORTEL (1-800-466-7835).

Outside North America, go to the following Web site to obtain the
telephone number for your region:

http://www.nortel.com/callus
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Getting help from a specialist by using an Express Routing Code
To access some Nortel Technical Solutions Centers, you can use an
Express Routing Code (ERC) to quickly route your call to a specialist in
your Nortel product or service. To locate the ERC for your product or
service, go to:

http://www.nortel.com/erc

Getting help through a Nortel distributor or re-seller
If you purchased a service contract for your Nortel product from a
distributor or authorized re-seller, contact the technical support staff for
that distributor or re-seller.
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Installation of DMC DECT Manager

• “Install DMC DECT Manager” (page 11)

• “Uninstall DMC DECT Manager” (page 16)

• “Upgrade DMC DECT Manager” (page 18)

• “Launch DMC DECT Manager” (page 20)

Manage DMC DECT Manager Installation
Use the procedures in this section to install, uninstall, upgrade and launch
the DMC DECT Manager application.

Install DMC DECT Manager

ATTENTION
The DMC DECT Manager application can not co-reside with Telephony
Manager.

Procedure 1
Installing DMC DECT Manager

Step Action

1 Double-click setup.exe from the DMC DECT Manager
Application installation package.

The Preparing to Install window appears.
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Figure 1
Preparing to Install window

The Welcome window appears.
Figure 2
Welcome window

2 Click Next.

The Choose Destination Location window appears.
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Figure 3
Choose Destination Location window

3 Click Next to continue with the default path selected, or click
Browse to choose a new destination location.

The Choose Folder window appears.
Figure 4
Choose Folder window

4 The selected settings are displayed in the Start Copying Files
window.

Nortel Communication Server 1000
Using the DMC DECT Manager

NN43001-142 01.01 4 June 2010

Copyright © 2010 Nortel Networks. All Rights Reserved.

.



14 Installation of DMC DECT Manager

Figure 5
Start Copying Files window.

5 Click Next.

6 The Installation program checks for the JRE and Access
Runtime prerequisites on the system.

If the prerequisites are present, the Installation program skips to
the DMC DECT Manager installation. Otherwise, the Installation
program installs the prerequisites.
Figure 6
Setup Status Installing JRE
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Figure 7
Setup Status Installing Access Runtime

7 The DMC DECT Manager installation starts.
Figure 8
Setup Status Installation Starts

8 Click Finish to complete the installation.
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Figure 9
InstallShield Wizard Complete

--End--

Uninstall DMC DECT Manager
The DMC DECT Manager Application must be closed before uninstalling
the application.

Procedure 2
Uninstalling DMC DECT Manager

Step Action

1 From the Windows Start menu, select Control Panel.

2 Double click Add or Remove Programs.

3 Select DMC DECT Manager in the list of programs and click
Remove.
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Figure 10
Add or Remove Programs window

4 Setup starts preparing for the uninstallation.
Figure 11
InstallShield Wizard

5 Uninstallation starts.
Figure 12
Uninstallation starts

6 Click Finish o complete the uninstallation of DMC DECT
Manager.
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Figure 13
Maintenance complete

--End--

Upgrade DMC DECT Manager
To upgrade DMC DECT Manager, follow the steps in Procedure 3
“Upgrading DMC DECT Manager” (page 18).

Procedure 3
Upgrading DMC DECT Manager

Step Action

1 Double click setup.exe from the DMC DECT Manager
Application package.
Figure 14
Preparing to Install

2 Click Next to continue with the upgrade.
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Figure 15
DMC DECT Manager InstallShield Wizard

The Start Copying Files window appears with the installed
location of DMC DECT Manager.
Figure 16
Start Copying Files window

3 Click Next to continue. The upgrade starts.
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Figure 17
Setup Status

4 Click Finish to complete the upgrade.
Figure 18
InstallShield Wizard Complete

--End--

Launch DMC DECT Manager
Installing DMC DECT Manager creates two shortcuts in Start, Programs,
Nortel DMC DECT Manager Menu:

• DMC DECT Manager.

Use the DMC DECT Manager shortcut to launch the DMC DECT
Manager application and to configure the DECT Access Systems.

• Backup Restore Utility.
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Use the Backup Restore Utility shortcut to launch the DECT Backup
and Restore utility.
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PBX System Configuration
A DMC DECT system is configured to a CS 1000 PBX for managing
handsets. Some of the DECT System parameters are computed based on
the type of CS 1000 system to which the DMC is configured.

To configure DECT Systems in DMC DECT Manager, the user must create
a PBX system with a name and type. The DMC DECT Manager supports
two types of PBX systems: “Large System” and “Small System”. Use the
following rules to determine the PBX system type.

• Rule 1: If the PBX Release number is 2111/2121 (Option11C /
OptionCSE11C), select Small System

• Rule 2: If the PBX Release number is anything other than 2111/2121,
select Large System

Manage the PBX System
Use the PBX System Properties window to add a PBX system, and to
modify or delete an existing PBX system.

Add a new PBX System
A PBX System must have a unique name and type (large system or small
system). A PBX System name must not contain any special characters.

Procedure 4
Adding a new PBX System

Step Action

1 Select Start, Programs, Nortel DMC DECT Manager, DMC
DECT Manager.

2 Select New PBX System from the Select drop down list.

New PBX System is the default setting.
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Figure 19
PBX System Properties

3 Enter the name of the new PBX system in the Name text box.

4 Select the type of PBX system from the Type drop down list.
There are two options: “Large System” and “Small System”.

5 Click Ok.

--End--

Use the DECT Access System (DAS) window to add DECT systems to
a PBX system.

Modify a PBX system
Use the PBX System Properties window to modify an existing PBX system.

Procedure 5
Modifying a PBX system

Step Action

1 Select the PBX system to be modified from the Select drop
down list.

The corresponding details for the selected PBX system are
displayed in the Details section.
Figure 20
PBX System Properties Details

2 Make the required modifications (for example, Name, Type) and
click Ok.
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Figure 21
PBX System Properties modifications

--End--

Remove a PBX system
Removing a PBX system removes all data pertaining to that PBX system
including DMC DECT systems configured in it.

Procedure 6
Removing a PBX system

Step Action

1 Select the PBX system to be removed from the Select drop
down list.

The corresponding details for the selected PBX system are
displayed in the Details section.
Figure 22
PBX System Properties remove

2 Click Remove.

A confirmation dialog window appears.
Figure 23
Remove System confirmation window

3 Click Yes to continue.
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The corresponding data of the selected PBX System is deleted.

--End--
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DECT Application features

DECT Application features
The DECT Application provides the following MDECT managing features.
The DECT Application allows you to do the following:

• view the MDECT System provisioning with the DECT Systems window

• view the DMC8 configuration with the Boards (DMC) window

• view base station configuration with the Radio Fixed Part (base
station) window

• view subscription information with the Subscriptions window

• upgrade Firmware using the DECT Systems window

• subscribe handsets using the Subscriptions window

• support DMC-8 and DMC (serial only)

• synchronize (update) the DECT Application database to the MDECT
system configuration when the DECT Manager connects to the
MDECT system

• collect performance data using the Performance Collection window

• view On-line Help
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DECT Systems window

• “What you can do with the DECT Systems window” (page 29)

• “DECT Systems window definition” (page 30)

• “Connecting to an MDECT system” (page 32)

• “DECT System Properties dialog” (page 33)

• “Firmware upload” (page 36)

What you can do with the DECT Systems window
This window allows you to:

• select an MDECT system to view database details or select all MDECT
systems to view database details

• add an MDECT system

• delete an MDECT system

• connect to, disconnect from, lock or unlock a connection between your
DECT Manager and an MDECT system

• open the following windows for selected MDECT systems

— “Subscriptions window” (page 39)

— “Boards (DMC) window” (page 55)

— “Radio Fixed Part (base station) window” (page 59)

— “Active Alarm Snapshot window” (page 63)

— “Performance Collection window” (page 67)

— “Retrieve RSSI Snapshot window” (page 69)
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DECT Systems window definition
The DECT Systems window displays the following:

• File, holds a pull-down menu that allows you to select one of the
following:

— Add, creates a new MDECT system with default values and opens
the System Properties dialog

— Delete, removes an MDECT system from the DECT Manager

— Connect / Lock / Disconnect, same functions as the
Connect/Disconnect tool

— Properties, opens the System Properties dialog

— Close, closes the client application and all DECT windows opened
by that client

• View, holds a pull-down menu that allows you to show or hide the:

— Tool bar

— Status bar

• Applications, holds a pull-down menu that allows you to open the
following windows:

— Subscriptions window

— Boards (DMC) window

— Radio Fixed Part (base station) window

— Current Alarms

— Performance Collection window

— Retrieve RSSI Snapshot window

• Firmware, holds a pull-down menu allowing you to open the following
windows:

— Upload, loads firmware to DMC (see “Firmware upload” (page 36))

— Activation, makes a firmware active

• Help, holds a pull-down menu that allows you to select:

— Content and Index

• Tool bar icon, that allows you to click the tool button to:

— Open a connection to an MDECT system selected in the List when
the Connection status shows Disconnected. When opened the icon
changes to red.

— Lock the connection to an MDECT system when the Connection
status is Connected. This prevents another user from closing the
connection.
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— Disconnect from an MDECT system when the Connection status is
Connected

— Unlock the connection from an MDECT system when the
Connection status is Connected Locked

Note: While the Connection status is Connecting or Disconnecting
the Connect/Disconnect tool is disabled. The status bar shows the
connection progress.

• List filter, allows you to select one of the following:

— This Meridian only, lists the MDECT System data you select from
the PBX System Properties Window

— All DECT Systems, lists every MDECT Systems data managed by
the DECT Manager

• List field, shows the following for the MDECT system or systems
selected from the M 1 System Window:

— Meridian 1 PBX name (see “DECT System Properties dialog -
General tab” (page 33))

— MDECT system name (see “DECT System Properties dialog -
General tab” (page 33))

— presence of an alarm (see “DECT System Properties dialog - Alarm
tab” (page 35))

— IP address, for the MDECT system (see “DECT System Detailed
Connection settings properties” (page 35))

— Primary Access Rights Identifier (see “DECT System Properties
dialog - Access Right Identification tab” (page 35))

— Concentration mode (see “DECT System Properties dialog -
Access Right Identification tab” (page 35))

— number of subscribed handsets (see “DECT System Properties
dialog - General tab” (page 33))

— connection status

• Connection status field, shows the current state of the connection,
where:

— Disconnected indicates no communication between the DECT
Manager and an MDECT system.

— Connected indicates communication between the DECT Manager
and an MDECT system for an operation initiated by a user. The
connection disconnects when the operation is finished.

• Operation progress field, shows the last received event associated
with the connection, such as:
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— Disconnecting

— Connecting

— Modem Busy

— Dialing

Connecting to an MDECT system
When you open the first connection to a new, installed MDECT system,
the DECT Manager Application retrieves the DMC configuration from the
DECT database. The DECT Manager Application reads the parameters
from the MDECT system for the manager database.

You can do one of the following to open a connection to an MDECT
system from a DECT Manager Application:

• check the Permanent Connection box, (see “DECT System Properties
dialog - Communication tab” (page 34)), allowing the connection to
open when the DECT Manager starts

• select an MDECT system in the list and click the Connect icon

• select an action on the menu bar that requires a system connection.
For example, Firmware > Upload; the connection opens to carry out
the upload and then closes.

Note: Avoid using this type of connection opening for subscription
actions otherwise the subscription status is not refreshed when an on-air
subscription or de-subscription occurs.

The status bar of the application provides progress feedback while the
connection is opening.

See also

• “Synchronization when the DECT Application connects to an MDECT
system” (page 32)

Synchronization when the DECT Application connects to an
MDECT system

When your DECT manager connects to the MDECT system,
synchronization occurs. Synchronization compares the database on your
manager to that of the MDECT system. Database mismatches are flagged
by dialogs. You then have the opportunity to change either the MDECT
system data or the manager data.
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A number of synchronization steps occur during connection.
Synchronization flags changes made to an MDECT system database by
other managers.

Two types of synchronization occur when the connection state goes from
Disconnected to Connected, as follows:

• when you use the File menu or tool button to connect. You can control
the synchronization through dialogs.

• when the DECT Manager re-establishes a permanent connection to
the MDECT system. A synchronization report is available in the Event
log on the DECT Manager.

When you connect to an MDECT system that has data that does not
match the DECT Manager Application data, choose one of the following:

• update the DECT Application database from the MDECT system data

• update the MDECT system data with the DECT Application database

DECT System Properties dialog
This dialog displays the DECT System Properties:

• “DECT System Properties dialog - General tab” (page 33)

• “DECT System Properties dialog - Communication tab” (page 34)

• “DECT System Properties dialog - Access Right Identification tab”
(page 35)

• “DECT System Properties dialog - Alarm tab” (page 35)

• “DECT System Properties dialog - Parameters tab” (page 36)

DECT System Properties dialog - General tab
The General tab allows you to do the following:

• view the Meridian 1 PBX name

• view or change the DECT System name (see “DECT System Name
Missing dialog” (page 34) and “DECT System Name Already in Use
dialog” (page 34))

• change the password (see “Change password dialog” (page 34))

• view if Concentration mode is active or Concentration mode is not
active

• view the number of subscribed handsets
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DECT System Name Missing dialog
The DECT System Name Missing dialog appears when a DECT System
name is not entered.

The application will not allow a system to be saved unless a name has
been provided and is unique.

DECT System Name Already in Use dialog
The DECT System Name Already in Use dialog appears when a DECT
System name is the same as the name of another system.

Change password dialog
The Change DECT System Password dialog is selected from the DECT
System Properties dialog, General tab.

If the new password does not match the confirmed password, a dialog
warns you that the passwords do not match and allows you to change the
passwords.

DECT System Properties dialog - Communication tab
The DECT System Properties dialog is selected from the File menu.

The Communication tab allows you to do the following:

• view or change the unique IP address, used if the connection is Serial
or Ethernet

• view the Subnetwork Mask

• view the Gateway IP address

• check a Permanent Connection, to:

— keep the connection open

— open the connection

• select Close Connection (see “Close Connection dialog” (page 35))

• select Ethernet or Serial connection

• select Details for the Serial connection (see “DECT System Detailed
Connection settings properties” (page 35))

• save a new MDECT system definition by pressing the OK button. This
causes the manager to try to connect to a new MDECT system and
write the system name in MIB2, after you:

— enter the new system IP address

— specify the new system name
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See also

• “DECT System Detailed Connection settings properties” (page 35)

Close Connection dialog
The Close Connection dialog is selected from the DECT System
Properties dialog, Communication tab.

DECT System Detailed Connection settings properties
System Detailed Connection settings properties is selected from the
Details button of DECT System Properties dialog - Communication tab.

The System Detailed Connection settings properties allows you to do the
following:

• view or change the DECT Manager IP interface assigned to the PC
RAS port interface on the same network as the DECT system

• view or select the COM Port attached to either the DECT system or
the modem

• select a modem mode

• view or change the Phone Number that dials the modem

DECT System Properties dialog - Access Right Identification tab
The DECT System Properties dialog is selected from the File menu.

There are two Access Right Identification, a Primary and a Secondary,
which identify each MDECT system. The Access Right Identification allows
you to do the following:

• view or change the PARI (see “Change PARI dialog” (page 52))

• view or change the SARI (A SARI dialog box is similar to the Change
PARI dialog)

See also

• “Change PARI dialog” (page 52)

DECT System Properties dialog - Alarm tab
The DECT System Properties dialog is selected from the File menu.
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The Alarm allows you to do the following:

• view a Yes or NO in the active alarm when the manager is connected
to an MDECT system with an active alarm.

• view or change the Upstream Manager IP address. The MDECT
system can send alarms to an upstream manager.

• view or change the Date and Time, used to timestamp alarms. When
not connected, the Date and Time fields are blank. When the MDECT
system is reset, the time and date are not updated.

DECT System Properties dialog - Parameters tab
The DECT System Properties dialog is selected from the File menu.

The Parameters allows you to do the following:

• view or change Tone Duration in milliseconds

• view or change Inter Digit Pulse width in milliseconds

• view or change Level 1 - low frequency in decibels

• view or change Level 2 - low frequency in decibels

• view or change Analog/Digital loss pad- handset to system in decibels

• view or change Analog/Digital loss pad- system to handset in decibels

• set all parameters to Factory Default values

Do not use the Advanced button as it can cause your system to fail.

The DECT System Properties Parameters are read from the MDECT
system on synchronization.

Firmware upload
The Firmware upload dialog is selected from the Firmware menu.

The designator DMC is used to differentiate between the NTCW00AA
DMC and the NTCW00AB DMC8.

This dialog alerts you that a DMC cannot support a firmware upload. If
you select OK, a file chooser lets you select a firmware file (see “Firmware
activation dialog” (page 37)), from the Client. When OKis selected, you
can replace the existing standby firmware with new firmware.

You can do one of the following:

• accept the firmware for the MDECT system

• cancel the firmware upload for the MDECT system
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Firmware activation dialog
This dialog allows you to select the firmware to activate on DECT system.
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Subscriptions window
The Subscriptions window is selected from the DECT Systems window
Applications menu.

• “What you can do with the Subscriptions window” (page 39)

• “Subscriptions window definition” (page 40)

• “Configure DECT subscription dialog” (page 43)

• “Enable a subscription” (page 43)

• “Disable subscriptions” (page 43)

• “Delete subscriptions” (page 44)

• “Copy subscriptions” (page 45)

• “Move subscriptions” (page 45)

• “Import subscriptions” (page 46)

• “Export subscriptions” (page 46)

• “Find subscriptions” (page 46)

• “Synchronize DECT and Station Administration Configuration” (page
46)

• “Meridian PBX to MDECT system synchronization” (page 50)

• “Multi Site Mobility Networking subscriptions” (page 50)

• “Force disable” (page 52)

• “Subscription properties” (page 53)

What you can do with the Subscriptions window
This window allows you to:

• connect to, disconnect from, lock or unlock a connection between your
DECT Manager and an MDECT system

• choose to show, in any combination, (see “Enable a subscription”
(page 43) and “Disable subscriptions” (page 43)) handsets that are:
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— Available

— Subscribed

— Enabled

— Blacklisted

— configured on one DMC8 or all DMC8s

• Subscribe (configure) handsets

• De-subscribe handsets

• Copy subscription data

• Move subscription data

• Delete subscription data

• Find subscription data

• Export subscription data

• Import subscription data

Note: Before a handset will work, the handset must be programmed on
the Meridian 1 PBX using LD 10.

Subscriptions window definition
The Subscriptions window displays the following:

• File, holds a pull-down menu allowing you to select one of the
following:

— Import, a subscription from a file (see “Import subscriptions” (page
46))

— Export, a subscription to a file (see “Export subscriptions” (page
46))

— Connect, Lock, Unlock, Disconnect

— Properties, includes data in the subscription list and International
Portable User Identifier (IPUI) (see “Subscription properties” (page
53))

— Close, the Subscriptions window

• View, holds a pull-down menu allowing you to show or hide the:

— Tool bar

— Status bar

• Edit, holds a pull-down menu allowing you to open the following dialog
boxes:
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— Copy (see “Copy subscriptions” (page 45))

— Delete (see “Delete subscriptions” (page 44))

— Find (see “Find subscriptions” (page 46))

• Operations, holds a pull-down menu allowing you to open the
following windows:

— Configure, allows you to program a handset on the Meridian 1
system (see “Configure DECT subscription dialog” (page 43))

— Set Default PARK, allows you to enter the default Portable Access
Rights Key (see “Multi Site Mobility Networking subscriptions”
(page 50))

— Enable, allows you to subscribe a handset

— Disable, allows you to de-subscribe a handset from one MDECT
system (see “Disable subscriptions” (page 43)) or de-subscribe
a handset from all MDECT systems (see “Multi Site Mobility
Networking subscriptions” (page 50) for example)

— Force Disable, allows you to return the subscription to the available
state, requests the system to disable the subscription. However,
there is no interaction between the system and handset (see “Force
disable” (page 52))

— Synchronize with Phone Data, allows the user to retrieve Meridian
1 handset configuration from a CSV file generated using the
EM Phone Provisioning application to synchronize and resolve
mismatches between Station Administration configuration and
DECT Application configuration (see “Synchronize DECT and
Station Administration Configuration” (page 46))

• Help, holds a pull-down menu allowing you to select:

— Content and Index

• Tool bar, allows you to click the tool button to:

— Connect, lock, unlock, disconnect, same function as DECT
Systems window

— Enable, allows you to subscribe a handset

— Disable, allows you to de-subscribe a handset

— Configure, allows you to program a handset

• List filter, allows you to show or hide details of handsets that are:

— available (see “Enable a subscription” (page 43) and “Disable
subscriptions” (page 43))

— subscribed (see “Enable a subscription” (page 43) and “Disable
subscriptions” (page 43))
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— enabled (see “Enable a subscription” (page 43) and “Disable
subscriptions” (page 43))

— black-listed (see “Enable a subscription” (page 43) and “Disable
subscriptions” (page 43))

— DMC restricts the list to subscription data for one DMC or lists
subscription data for all DMC

• List, shows the following subscription details for handsets assigned to
a <sitename>, a <PBX name>, a <DECT system name>:

— DMC TN

— index, 32 units or 510 virtual units for concentration on a DMC

— concentrated handset Home DN

— concentrated handset Local DN, different than Home DN for visitor
concentrated handset

— virtual TN for concentration handsets

— subscription PARK

— subscription status, updated by SNMP traps from the MDECT
system

— PIN code shown during subscription activation

— an 80-character comment

• Pop up menu, available when at least one subscription is selected,
contains the following items:

— Configure

— Enable

— Disable

— Copy

— Move

— Delete

— Export

— Properties

— Help

• Status bar, shows:

— connection status

— operation status

— current subscription PARK
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Configure DECT subscription dialog
Configure DECT Subscription allows you to:

• select a DMC TN

• enter the first subscription index (unit, as in l s c u)

• select a number of consecutive subscriptions

When configured, the subscription becomes available and you can enable
the subscription. During the enable process, the DECT manager generates
a PIN code for the subscription (see “Enable a subscription” (page 43)).

Enable a subscription
Available - DECT channel is configured and available for subscription.

Enabled - The subscription process starts with the user selecting the
handsets and pulling down the Operations menu and then clicking on
Enable.

Pin code entered within 15 minutes? The DECT Manager provides a PIN.

Subscribed – The handset is now ready to make and receive calls.

Disable subscriptions
You can de-subscribe a subscription on:

• a single handset

• a list of selected handsets

• all handsets on a DMC

Subscribed – The handset can make and receive calls. The
de-subscription process starts with the user selecting the handsets and
pulling down the operations menu then clicking on Disable.

Black listed – The following conditions must exist

• Connection with the system

• Handset in range

• Handset on

• Handset go off-hook or called

Available – Handset ready for subscription

Launching an on-air de-subscription requires an open connection to the
MDECT system.
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When the DECT Manager starts the de-subscription, the MDECT system
holds the de-subscription until one of the following occurs:

• the handset makes or receives a call

• the DECT Manager removes the subscription

The MDECT system notifies the DECT Manager that the handset is
de-subscribed.

The DECT manager can stop a handset from operating on all the MDECT
systems where the handset is subscribed with a given International
Portable User Identifier (IPUI).

To stop a handset from operating, requires that the handset is within radio
range and ready for on-air de-subscription. The process removes handset
subscription data from the following:

• the MDECT system DMCs

• the handset

• the DECT managers handset and MDECT system files

When the handset’s subscription data is removed, the handset no longer
works on any MDECT system.

Delete subscriptions
The Delete operation allows you to remove handset information from
the manager and the MDECT system, but not the handset. The Delete
operation does not require the handset to be available for on-air
de-subscription. The Delete operation does the following:

• removes the MDECT system handset subscription data

• retains the handsets subscription data, if the handset had subscription
data (As the handset does not remove its subscription data, it
continues operating on all the MDECT systems where this subscription
is relevant.)

• removes the DECT manager handsets subscription data including
comments and Meridian 1 PBX Station Administration data

The DECT Manager provides the ability to remove subscription records
from the following:

• a single handset subscription

• a list of selected subscriptions

• a DMC or from all DMCs at once
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The subscription removal requires an open connection to the MDECT
system.

You can remove subscription records to:

• clean a Multi Site Mobility Networking MDECT system subscriptions on
the distributors premises

• move a DMC from one MDECT system to another

Copy subscriptions
The Copy Subscription dialog is selected from the Edit menu.

The copy dialog allows you to copy subscriptions from a DMC on MDECT
system A and paste the subscriptions into a DMC on MDECT system B.
The subscriptions have to be in the Subscribed status.

You select the Destination MDECT system and the Destination DMC from
the DECT Copy Subscription dialog. The connection to the destination
system must be open.

You can copy subscriptions from the following:

• a single handset subscription

• a list of selected subscriptions

• a DMC

Note: You cannot copy subscriptions within the same MDECT system.
When a subscription is copied, only the MDECT system data is copied,
not the Meridian 1 PBX data.

In the DECT Copy Subscription dialog the source subscription data
is in the three left columns; DMC TN, Index, and Local DN. You view
the source subscription from the Subscription window. The destination
subscription data is in columns To: DMC TN, and To: Index. Index is
the Unit on the DMC. When the dialog opens, the source DMCs and
destination DMCs are the same.

When you copy, you must connect to the destination MDECT system.

The Copy Subscription feature provides a way to support Multi Site
Mobility Networking, by allowing you to subscribe handsets without being
on the Distributor Premises.

Move subscriptions
The Move Subscriptions dialog is selected from the Edit menu.
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Move Subscriptions is similar to Copy, except for the following. The move
dialog allows you to cut/remove subscriptions from a DMC on MDECT
system A, and paste the subscriptions into a DMC on the same MDECT
system, or MDECT system B.

When you move, you must connect to both the source MDECT system
and the destination MDECT system.

Import subscriptions
The Import Subscriptions dialog is selected from the File menu.

Import Subscriptions is similar to Copy, except for the following. The
import dialog allows you to copy subscriptions from an import file and
paste the subscriptions into a DMC on an MDECT system.

To paste a subscription, you must be connected to an MDECT system.

Export subscriptions
The Export Subscriptions dialog is selected from the File menu.

Export Subscriptions is similar to Copy, except for the following. The
export dialog allows you to copy subscriptions from an MDECT system and
paste the subscriptions into a file.

Note: Import/Export are used to support Multi Site Mobility Networking
and Subscription on the Distributor Premises to a MDECT system
normally managed by TM "B", not your TM "A".

Find subscriptions
The Find Subscriptions dialog is selected from the Edit menu.

The Find operation allows you to find subscription information by searching
for an IPUI or a Home DN, using the Find DECT Subscription dialog.

The find action displays the subscription information in the Find DECT
Subscription Result dialog.

Synchronize DECT and Station Administration Configuration
Synchronizing phone data from a CSV file generated using the EM Phone
Provisioning application allows the user to retrieve Meridian 1 handset
configuration and resolve mismatches between Station Administration
configuration and DECT Application configuration. To synchronize DECT
and Station Administration Configuration, use the EM Phone Provisioning
application to generate a CSV file with phone details. A report profile is
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available under <DMC DECT Manager Root>/Data directory. Upload the
report profile to the EM Phone Provisioning application and generate the
required CSV file for DMC DECT.

The CSV report contains all phones having WTYP=’DECT’ and
WRLS=’YES’ for a particular element in UCM. The CSV report has the
following format:

Table 1
CSV report format

Sl. No. Phone Feature Phone Feature Description

1 INDX Index on DMC

2 HMDN Home Directory Number

3 VSIT Visiting DECT Set

4 PRIMEDN Prime DN

5 TN Terminal Number

6 DMC DECT mobility controller

Procedure 7
Synchronizing DECT and Station Administration Configuration

Step Action

1 Select Start, Programs, Nortel DMC DECT Manager, DMC
DECT Manager.

2 Select the required PBX System from the list of PBX systems
and click Ok.
Figure 24
DMC DECT System Window

The DMC DECT System Window appears.

3 Select the required DECT System and click Applications,
Subscriptions.
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Figure 25
Applications Subscriptions

4 Click on Subscriptions.

The Subscription Window appears.
Figure 26
Subscription Window

5 Click on Operations, Synchronize with phone data
Figure 27
Operations Synchronize with phone data

6 Click on Synchronize with phone data. Browse to the CSV
report having phone data and click Import.
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Figure 28
Import Subscriptions

The DECT and Station Administration Mismatch window
appears, if there is a mismatch between the DMC DECT
Manager data and the CSV report.
Figure 29
DECT and Station Administration Mismatch

If there is no mismatch, synchronization is completed and
the subscriptions in the CSV file are imported to DMC DECT
Manager.
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Figure 30
Subscriptions Imported

--End--

Meridian PBX to MDECT system synchronization
If the Meridian PBX configuration data is available in the form of a CSV
file generated from the EM Phone Provisioning application, then a
synchronization facility is available to import the data into DMC DECT
Manager. Synchronization follows the following rules:

• A handset not listed in the DECT Manager but present in the PBX is
added in the DECT Manager list.

• If the DECT Manager lists a handset but the CSV file does not, the
DECT Manager prompts you to either keep or remove the handset.

Add handsets to the DECT manager by selecting Configure from the
Operations menu.

The Synchronize DECT and Station Administration Mismatch dialog
highlights DMC TNs in the DECT managers that are not configured in
the EM Phone Provisioning application database. You can check those
subscriptions that you must keep in the DECT manager.

If there is no mismatch that DECT Manager cannot resolve automatically,
the Synchronize DECT and Station Administration dialog does not
appear. For example, there are no entries in the EM Phone Provisioning
application database, or the DECT Manager does not have a DMC
configured in a Meridian 1 PBX TN location, where an entry does exist in
the EM Phone Provisioning database.

Multi Site Mobility Networking subscriptions
In Multi Site Mobility Networking (MSMN), a handset is subscribed in a
given MDECT system and used in one or many MDECT systems.
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Every handset has a Portable Access Rights Key (PARK). Every MDECT
system has a Primary Access Rights Identifier (PARI), and can have a
Secondary Access Rights Identifier (SARI).

The handset PARK and MDECT system PARI and SARI are used by
the handset and MDECT system to identify each other. The PARK and
PARI/SARI match allow the handset to work with an MDECT system.

In an MSMN network, for example, MDECT system "A" has a PARI
matching a handset PARK and MDECT systems "B", "C", and "D" have a
SARI matching the handset PARK.

The DECT Manager user programs the SARI in the MDECT system. The
DECT Manager provides the PARK during the on-air subscription, and
the PARK is programed into the handset at subscription time (see “DECT
System Properties dialog - Access Right Identification tab” (page 51) and
“Change PARI dialog” (page 52)).

For example, you can subscribe a handset on an MDECT system on a
distributors premises, where the handset is not to be in operation. You
then download the subscription data to an MDECT system where the
handset is to be in operation. The PARI of the MDECT system where the
handset is subscribed and the SARI of the MDECT system where you use
the handset are not always the same. You provide the PARK matching the
destination MDECT system to the handset during the on-air subscription.

The DECT Manager provides the ability to specify the PARK given to the
handset, to support Multi Site Mobility Networking and Subscription on the
distributor premises (see “Change PARI dialog” (page 52)). The PARK
normally defaults to the PARI of the system where the on-air subscription
occurs. For MSMN, you must set the default PARK equal to the network
SARI value before any subscription activity.

The PARK used by the DECT subscription application is subject to the
following:

• PARK is limited to the lifetime of the subscription application

• two different users can use a different PARK on the same MDECT
system at the same time

• PARK is not recorded in persistent storage

DECT System Properties dialog - Access Right Identification tab
The DECT System Properties dialog is selected from the File menu.
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There are two Access Right Identification, a Primary and a Secondary,
which identify each MDECT system. The Access Right Identification allows
you to do the following:

• view or change the PARI (see “Change PARI dialog” (page 52))

• view or change the SARI (A SARI dialog box is similar to the Change
PARI dialog)

See also

• “Change PARI dialog” (page 52)

Change PARI dialog
The Change PARI dialog appears when you press the Change PARI
button of the Access Right Identification.

You must not change the PARI or SARI until you connect to the MDECT
system requiring the new PARI or SARI.

During synchronization, a dialog warns you if a MDECT system has a
different PARI or SARI than the DECT manager.

See “Multi Site Mobility Networking subscriptions” (page 50) for additional
information about changing the PARI and SARI.

Force disable
The Force disable DECT Subscriptions dialog is selected from the
Operations menu.

Force Disable returns the subscription to the available state, requests
the system to disable the subscription. However, there is no interaction
between the system and handset.

You can use Force Disable when the handset is not in range or on-air.

Use on this DECT System only or if you want to remove the handset
subscription from only this MDECT system and remove the handset
subscription from all other MDECT systems in the background.

Use on all DECT Systems where it is present? if you want to remove
the handset subscription from all systems at the same time.
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Subscription properties
The Subscription properties sheet is selected from the File menu.

• “What you can do with the Subscription properties sheet” (page 53)

• “Subscription properties sheet definition” (page 53)

What you can do with the Subscription properties sheet
This properties sheet allows you to:

• view the DMC Terminal Number

• view the Index. Index is the TN unit, as programmed in LD 10 in a
non-concentrated system, and a virtual TN unit in a concentrated
system.

• change and apply Comments, up to 80 characters

• view Home Directory Number (where the handset is configured on the
Meridian PBX as the home location)

• view Local Directory Number

• view Home handset only

• view handset Virtual Terminal Number

• view the International Portable User Identifier (IPUI)

• view the subscription PARK

• view the subscription status

• view the subscription PIN

Subscription properties sheet definition
The Subscription properties sheet displays the same subscription data as
the Subscriptions window list items.

Nortel Communication Server 1000
Using the DMC DECT Manager

NN43001-142 01.01 4 June 2010

Copyright © 2010 Nortel Networks. All Rights Reserved.

.



54 Subscriptions window

Nortel Communication Server 1000
Using the DMC DECT Manager

NN43001-142 01.01 4 June 2010

Copyright © 2010 Nortel Networks. All Rights Reserved.

.



55
.

Boards (DMC) window
The Boards window is selected from the DECT Systems window
Applications menu:

• “What you can do with the Boards (DMC) window” (page 55)

• “Boards (DMC) window definition” (page 55)

• “Board (DMC) properties sheet” (page 57)

What you can do with the Boards (DMC) window
This window allows you to:

• examine DMC details

• connect to, disconnect from, lock or unlock a connection between your
DECT Manager and an MDECT system

• choose to show operational DMC, or non-operational DMC or both

• open a properties sheet

Boards (DMC) window definition
The Boards window displays the following DMC data:

• File, holds a pull-down menu allowing you to select one of the
following:

— Clear, erases all subscriptions, sets all base stations to installed
status and line powered, allowing you to program the DMC in a
new MDECT system

— Connect, Lock, Unlock, Disconnect, works the same as the
Connect/Disconnect tool

— Properties

— Close, closes the DMC window

• View, holds a pull-down menu allowing you to show or hide the:
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— Tool bar

— Status bar

• Synchronization, holds a pull-down menu allowing you to:

— Synchronize From, subscription and base station alarm
muting/power source configuration data from a DMC to the DECT
Manager

— Synchronize To, subscription and base station alarm muting/power
source configuration data from the DECT Manager to a DMC

• Help, holds a pull-down menu allowing you to select:

— Content and Index

• Tool bar, allows you to click the tool button to:

— Connect, lock, unlock, disconnect

• List filter, allows you to show list details of only the operational DMC
or non-operational DMC or both

• List, shows the following DMC details:

— DMC TN

— DMC type

— relay DMC

— operational state, when DMC operational status changes, the
DECT Manager updates the status

— Number of handsets on a DMC

— an 80-character comment

• Pop up menu,

— Synchronize from DMC

— Synchronize to DMC

— Properties

— Help

• Properties, displays additional information about DMC. Only the
comment can be modified.
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Board (DMC) properties sheet
The Board properties sheet is selected from the File menu.

• “What you can do with the Board properties sheet” (page 57)

What you can do with the Board properties sheet
This properties sheet allows you to:

• view DMC details

• view operational status. When the DMC operational status changes on
the MDECT system, the TM updates the status

• change and apply Comments, up to 80 characters

• view DMC Type Number

• view DMC Manufacture Code

• view DMC Standby Software Package

• view DMC Boot Package

• view DMC Protocol Version

• open the help file

• close the properties sheet
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Radio Fixed Part (base station) window
The Radio Fixed Part window is selected from the DECT Systems window
Applications menu:

• “What you can do with the Radio Fixed Part (base station) window”
(page 59)

• “Radio Fixed Part (base station) window definition” (page 59)

• “Radio Fixed Part (base station) properties sheet” (page 61)

What you can do with the Radio Fixed Part (base station) window
This window allows you to:

• examine base station details

• connect to, disconnect from, lock or unlock a connection between your
DECT Manager and an MDECT system

• choose to show Muted base stations, or Not Muted base stations or
both

• cancel mute allows a base station to generate alarm messages or
mute keeps a base station from generating alarm messages

• open a properties sheet

Radio Fixed Part (base station) window definition
The Radio Fixed Part window displays the following base station data:

• File, holds a pull-down menu allowing you to select one of the
following:

— Connect / Lock / Unlock / Disconnect, same functions as the
Connect / Disconnect tool

— Properties, opens the Radio Fixed Part properties sheet

— Close, closes the Radio Fixed Part window

• View, holds a pull-down menu allowing you to show or hide the:
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— Tool bar

— Status bar

• Edit, holds a pull-down menu allowing you to:

— Mute Alarms, keeps a selected base station from generating alarms

— Cancel Mute Alarms, allows a selected base station to generate
alarms

Note: You can view alarms on the Active Alarm Snapshot window.

• Help, holds a pull-down menu allowing you to select:

— Content and Index

• Tool bar icon, allows you to click the tool button to:

— Connect, lock, unlock, disconnect

— Mute Alarms, keeps a selected base station from generating alarms

— Cancel Mute Alarms, allows a selected base station to generate
alarms

• List filter, allows you to select a list showing base stations allowed to
generate alarms, or base stations not allowed to generate alarms, or
both

• List, displays:

— DMC TN, connected to a base station

— Radio Identifier, identifies the base station (1 to 4) connected to the
DMC and the base station (1 to 8) connected to the DMC8

— Operational State, indicates if a base station is operational or is not
operational

— Alarm Muted, indicates if a base station is allowed to generate
alarms or not

— Number of Channels, identifies the base station as either a
6-channel or a 12-channel base station

— Comment, an 80-character comment field in the DECT application

• Pop-up menu, appears when at least one RFP is selected, and
you right click the mouse. Selecting one or more Radio Fixed Part
(click/double-click on a Radio Identifier or highlight a row in the list)
displays a menu with the following:

— Properties

• Help allows you to select Content and Index or About DECT
application
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Radio Fixed Part (base station) properties sheet
The Radio Fixed Part properties sheet is selected from the pop-up menu.

• “What you can do with the Radio Fixed Part properties sheet” (page
61)

• “Radio Fixed Part properties sheet definition” (page 61)

What you can do with the Radio Fixed Part properties sheet
This properties sheet allows you to:

• view base station details

• view Operational Status. When base station operational status
changes, the DECT Manager updates the status

• change and apply Alarm Muting

• change and apply Comments, up to 80 characters

• select Line Power (powered by DMC) or Local Powered

• open the help file

• close the properties sheet

Radio Fixed Part properties sheet definition
The Radio Fixed Part properties sheet displays the same base station
data as the Radio Fixed Part window list items. The properties sheet also
shows the power source for the selected base station.
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Active Alarm Snapshot window
The Active Alarm Snapshot window is selected from the DECT Systems
window Applications menu.

• “What you can do with the Active Alarm Snapshot window” (page 63)

• “Active Alarm Snapshot window definition” (page 63)

• “Active Alarm Snapshot properties sheet” (page 64)

What you can do with the Active Alarm Snapshot window
This window allows you to:

• connect to the Active Alarm Snapshot window

• refresh the window

• open a properties sheet

Active Alarm Snapshot window definition
The Active Alarm Snapshot window displays the alarm data stored in the
DMC. The alarm data displayed does not change or update until manually
refreshed

• File, holds a pull-down menu allowing you to select one of the
following:

— Connect / Lock / Unlock / Disconnect, same functions as the
Connect / Disconnect tool

— Properties, opens the Active Alarm Snapshot properties sheet

— Close, closes the Active Alarm Snapshot window

• View, holds a pull-down menu allowing you to select:
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— Tool bar, to show or hide

— Status bar, to show or hide

— Refresh, updates the Active Alarm Snapshot window with the
latest alarm data from the MDECT system selected in the title bar.
You cannot select a separate DMC TN to refresh.

• Help, holds a pull-down menu allowing you to select:

— Content and Index

• Tool bar, allows you to click the tool button to:

— Connect, lock, unlock, disconnect

— Refresh, updates the Active Alarm Snapshot window with the
latest alarm data from the MDECT system selected in the title bar.
You can not select a separate DMC TN to refresh.

• List, shows read-only data about:

— Severity, always labeled as Critical

— Error Code, a three digit code. Refer to the Meridian Companion
DECT Operation Administration and Maintenance NTP for the
meaning of the Error Codes

— DMC TN, indicates the location of the card that originated the alarm

— Radio Identifier (base station identifier), indicates the base station
that is the source of an alarm

— Date and Time, when the alarm occurred

— Operator Data, describes the alarm and the faulty component if
applicable

• Pop-up menu, appears when at least one RFP is selected, and you
right click the mouse.

— Properties

• Help displays Content and Index, and About DECT application

Active Alarm Snapshot properties sheet
The Active Alarm Snapshot properties sheet is selected from the pop-up
menu.

• “What you can do with the Active Alarm Snapshot properties sheet”
(page 65)

• “Active Alarm Snapshot properties sheet definition” (page 65)
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What you can do with the Active Alarm Snapshot properties sheet
This properties sheet allows you to:

• view alarm (MDECT system message) details

• close the properties sheet

• open the help file

Active Alarm Snapshot properties sheet definition
The Active Alarm Snapshot properties sheet displays the same alarm data
as the Active Alarm Snapshot window list items.
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Performance Collection window
The Performance Collection window is selected from the DECT Systems
window Applications menu.

• “What you can do with the Performance Collection window” (page 67)

• “Performance Collection window definition” (page 67)

• “Performance Collection additional information” (page 67)

What you can do with the Performance Collection window
This window allows you to:

• start and stop User Performance Collection counters

• start and stop Equipment Performance Collection counters

Performance Collection window definition
The Performance Collection window displays the following:

• Name, allows you to select the directory where you want to store the
Performance Collection file.

• User Performance Collection, collects counter data on handset user
related activities.

• Equipment Performance Collection, collects counter data on DMC
related activities.

Performance Collection additional information
The DECT Manager user starts and stops performance counter collection.
You can not schedule performance collection. The collection begins when
you start it and ceases when you stop it.

You can set the collection period for 15 minutes, 30 minutes, one hour,
one day. The performance counters are on the DMCs. You can select
DMC TNs.
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You can collect User (handset) data and Equipment (MDECT system) data
separately. You can set User (handset) data and Equipment (MDECT
system) data collection periods separately.

The DECT Manager stores the performance files. Rebooting the DECT
Manager does not destroy the files. The back up and restore application
on the DECT Manager does not back up and restore the performance files.
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Retrieve RSSI Snapshot window
The Retrieve RSSI Snapshot window is selected from the DECT Systems
window Applications menu.

• “What you can do with the Retrieve RSSI Snapshot window” (page 69)

• “Retrieve RSSI Snapshot window definition” (page 69)

• “Retrieve RSSI Snapshot attributes” (page 69)

What you can do with the Retrieve RSSI Snapshot window
This window allows you to:

• view Radio Signal Strength Indication details

• scroll and select a DMC for RSSI information retrieval

Retrieve RSSI Snapshot window definition
The Retrieve RSSI Snapshot window collects, on request, the RSSI for
selected DMC.

Retrieve RSSI Snapshot attributes
The DECT Manager collects the RSSI as an ASCII file. The DECT
Manager user must indicate where to store the RSSI file.
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Backup and Restore utility

• Procedure 8 “Backup DECT data” (page 71)

• Procedure 9 “Restore DECT data” (page 73)

DECT Data Backup and Restore operations are performed using the DMC
DECT Backup and Restore utility.

The DECT Data backup file contains all configured PBX Systems,
corresponding DECT systems and other configuration data compressed
in a file with .bak extension.

The Backup utility automatically generates a backup file name during a
backup operation. The user can change the filename, if required, but, the
filename should always have .bak extension. A backup file, by default, has
the following format: DMC_DECT_BACKUP_mm_dd_yyyy.bak

During the restore operation, a user selects a backup file and replaces the
existing configuration in the DMC DECT Manager with the configuration
available in the backup file. Note that the restore operation does not
compare the data in the backup file with existing data.

Procedure 8
Backup DECT data

Step Action

1 Click Start, Programs, Nortel DMC DECT Manager, Backup
Restore Utility
Figure 31
Backup and Restore
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72 Backup and Restore utility

2 Select the Backup option. (The backup option is selected by
default.)

3 Click the File browse button to select the directory and provide
the backup file name. Ensure that the file extension is .bak.
Figure 32
Browse to select directory

4 Click OK.

5 Click Yes to proceed with the backup.
Figure 33
Backup confirmation

6 Click OK.
Figure 34
Backup completed

--End--

Note that

• Basic validation is performed during the backup operation.

• File name is mandatory

• Verify the extension of the file. File extension must be .bak
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Procedure 9
Restore DECT data

Step Action

1 Click Start, Programs, Nortel DMC DECT Manager, Backup
Restore Utility
Figure 35
Backup and Restore

2 Select the Restore option. (The backup option is selected by
default.)
Figure 36
Restore option

3 Click the File browse button to select the DECT backed up file.
Figure 37
Browse to backed up file

4 Click OK.

5 Click Yes to proceed with the restore.
Figure 38
Restore confirmation

6 Click OK.
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Figure 39
Restore completed

--End--

Nortel Communication Server 1000
Using the DMC DECT Manager

NN43001-142 01.01 4 June 2010

Copyright © 2010 Nortel Networks. All Rights Reserved.

.





Nortel Communication Server 1000

Using the DMC DECT Manager
Release: 7.0
Publication: NN43001-142
Document revision: 01.01
Document release date: 4 June 2010

Copyright © 2010 Nortel Networks. All Rights Reserved.

While the information in this document is believed to be accurate and reliable, except as otherwise expressly agreed to in writing
NORTEL PROVIDES THIS DOCUMENT "AS IS" WITHOUT WARRANTY OR CONDITION OF ANY KIND, EITHER EXPRESS
OR IMPLIED. The information and/or products described in this document are subject to change without notice.

Nortel, Nortel Networks, the Nortel logo, and the Globemark are trademarks of Nortel Networks.

All other trademarks are the property of their respective owners.

To provide feedback or to report a problem in this document, go to www.nortel.com/documentfeedback.

www.nortel.com


	toc
	New in this release
	Other Changes
	Revision History


	How to get help
	Getting help from the Nortel Web site
	Getting help over the telephone from a Nortel Solutions Center
	Getting help from a specialist by using an Express Routing Code
	Getting help through a Nortel distributor or re-seller

	Installation of DMC DECT Manager
	Manage DMC DECT Manager Installation
	Install DMC DECT Manager
	Procedure 1 

	Uninstall DMC DECT Manager
	Procedure 2 

	Upgrade DMC DECT Manager
	Procedure 3 

	Launch DMC DECT Manager


	PBX System Configuration
	Manage the PBX System
	Add a new PBX System
	Procedure 4 

	Modify a PBX system
	Procedure 5 

	Remove a PBX system
	Procedure 6 



	DECT Application features
	DECT Application features

	DECT Systems window
	What you can do with the DECT Systems window
	DECT Systems window definition
	Connecting to an MDECT system
	Synchronization when the DECT Application connects to an MDECT system
	DECT System Properties dialog
	DECT System Properties dialog - General tab
	DECT System Name Missing dialog
	DECT System Name Already in Use dialog
	Change password dialog
	DECT System Properties dialog - Communication tab
	Close Connection dialog
	DECT System Detailed Connection settings properties
	DECT System Properties dialog - Access Right Identification tab
	DECT System Properties dialog - Alarm tab
	DECT System Properties dialog - Parameters tab
	Firmware upload
	Firmware activation dialog

	Subscriptions window
	What you can do with the Subscriptions window
	Subscriptions window definition
	Configure DECT subscription dialog
	Enable a subscription
	Disable subscriptions
	Delete subscriptions
	Copy subscriptions
	Move subscriptions
	Import subscriptions
	Export subscriptions
	Find subscriptions
	Synchronize DECT and Station Administration Configuration
	Procedure 7 

	Meridian PBX to MDECT system synchronization
	Multi Site Mobility Networking subscriptions
	DECT System Properties dialog - Access Right Identification tab
	Change PARI dialog

	Force disable
	Subscription properties
	What you can do with the Subscription properties sheet
	Subscription properties sheet definition


	Boards (DMC) window
	What you can do with the Boards (DMC) window
	Boards (DMC) window definition
	Board (DMC) properties sheet
	What you can do with the Board properties sheet


	Radio Fixed Part (base station) window
	What you can do with the Radio Fixed Part (base station) window
	Radio Fixed Part (base station) window definition
	Radio Fixed Part (base station) properties sheet
	What you can do with the Radio Fixed Part properties sheet
	Radio Fixed Part properties sheet definition


	Active Alarm Snapshot window
	What you can do with the Active Alarm Snapshot window
	Active Alarm Snapshot window definition
	Active Alarm Snapshot properties sheet
	What you can do with the Active Alarm Snapshot properties sheet
	Active Alarm Snapshot properties sheet definition


	Performance Collection window
	What you can do with the Performance Collection window
	Performance Collection window definition
	Performance Collection additional information

	Retrieve RSSI Snapshot window
	What you can do with the Retrieve RSSI Snapshot window
	Retrieve RSSI Snapshot window definition
	Retrieve RSSI Snapshot attributes

	Backup and Restore utility
	Procedure 8 
	Procedure 9 



